GRADUATE COUNCIL: NEW COURSE PROPOSAL

Originating Unit: NEELEY (ENTR)

Type of action: New course |:| Full online course**

Semester and year course will take effect: Spring 2023

New course title: Data Analytics Capstone for Entrepreneurial Decision Making
Appropriate computer abbreviation (30 spaces or less): DA Entrepreneurial Capstone
Course instructional methodology: [ecture

course component types: ugradcouncil.tcu.edu/forms/Course Component Types.pdf

New course number: 70630

Prerequisites for new course: include an attachment if additional space is needed
Admitted o Master of Science in Business Analytics program

Click here to attach. attached files can be seen and managed in Acrobat Pro by clicking on
eto attach a file View > Show/Hide > Navigations Panes > Attachments
o |
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Description of new course (catalog copy): include an attachment if additional space is néeded

This course is designed to prepare students to recognize challenges faced by organizations and to
create innovative, value-oriented solutions using analytical methods. Students engage with business
professionals to define a business issue, identify the necessary data and resources needed to provide
solutions, and ultimately communicate those solutions to management.

Click herezto attach a fil attached files can be seen and managed in Acrobat Pro by clicking on
: ' ° View > Show/Hide > Navigations Panes > Attachments




Fully Onrline Courses**

All online courses, and /or distance learning offerings must meet State Compliance regulations as defined by specific state
legislation. TCU Distance Learning is any for-credit instruction provided to a TCU student outside the State of Texas.
This includes internships, clinical, video conferencing, online, or any other delivery format that crosses state lines.

Contact the Koehler Center for Teachmg Excellence for gu:delmes Include a letter of support from the Koehler Center
with this proposal.

Supporting evidence or justification: (For a new course, attach proposed syliabus, including course objectives,
course outline, and representative bibliography.)

Describe the intended outcomes of the course and how they will be assessed: include an attachment if
additional space is needed
See attached syllabus.

attached files can be seen and managed in Acrobat Pro by clicking on
View > Show/Hide > Navigations Panes > Attachments

. |€lickhereltolattachlalfile
Additional resources required:

Faculty: none
Space: none
Equipment: none
Library: none
Financial Aid: none.
Other: lnone

Change in teaching load: ngo

Does this change affect any other units of the University? D Yes No
If yes, submit supporting statement signed by chair of affected unil.

If cross-listed, provide evidence of approval by all curriculum committees appropriate to both the originating and
the cross-listed units.
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Data Analytics Capstone for Entrepreneurial Decision Making
Instructor: Michael Sherrod
OFFICE PHONE: 817-257-5735 / MOBILE: 817-320-2886
E-MAIL: m.s.sherrod@tcu.edu
OFFICE: Smith Hall, Neeley 3502E
OFFICE HOURS: Before and after class or
Please call or email me anytime me for an appointment

Recording of Class Sessions:

If there is ever a need for an online class the class sessions will all be recorded for use by
enrolled students, including those who are unable to attend live. Students who participate with
their camera engaged or utilize a profile image are consenting to have their video or image
recorded. If you are unwilling to consent to have your profile or video image recorded, be sure
to keep your camera off and do not use a profile image. Likewise, students who un-mute during
class and participate orally are consenting to have their voices recorded. If you are not willing to
consent to have your voice recorded during class, you will need to keep your mute button
activated and communicate exclusively using the "chat" feature, which allows students to type
questions and comments live.

Campus Life and the Student Experience will Be Different This Year. The health and safety of
students, faculty, and staff is Texas Christian University’s highest priority. TCU has implemented
public health interventions, which includes following local and state public health orders and
CDC guidelines. These health interventions may impact your experience as a student both
inside and outside the classroom. Safety protocols may change during the semester and may
result in modifications or changes to the teaching format, delivery method, or the course
schedule (e.g., altering meeting times or frequency; changing beginning or ending dates for a
term; or partially or completely moving from a face-to-face classroom teaching to an online
teaching or remote learning format). Any changes in teaching format, delivery method, or
course schedule will not impact the credit hours for the course.

Health and Wellness: If you are exhibiting symptoms that may be related to COVID-19 (fever or
chills, dry cough, shortness of breath, etc.) or are concerned that you may have been exposed
to COVID-19, you must self-quarantine and consult with the Brown Lupton Health Center at
817-257-7949 for further guidance.

In addition, you must notify the Campus Life Office immediately at 817-257-7926. Campus Life
will inform your professors that you are unable to attend class, and provide any assistance and
support needed. Click here for detailed information concerning COVID-19 symptoms:
https://www.cdc.gov/coronavirus.

If you are unwell, but are not exhibiting potential COVID-19-related symptoms, please notify
your instructor as soon as possible that you are ill and will not be attending class.

If you do not feel well enough to attend class in person, but feel well enough to attend class
remotely, please notify your instructor as soon as possible before the class begins to arrange
attendance via video conferencing.




Face Coverings and Physical Distancing: Face coverings are required on campus, unless you are
alone in your private office or dorm room. Students will be expected to practice physical
distancing and wear protective face coverings at all times while in public spaces on the TCU
campus. Failing to do so in the classroom could result in the student being asked to leave the
room and continue the class through remote access. Additionally, the instructor has the option
to terminate the class period and continue it as a remote session if students do not wear
required masks or practice physical distancing.

Student Access and Accommodation: Texas Christian University affords students with
disabilities reasonable accommodations in accordance with the Americans with Disabilities Act
and Section 504 of the Rehabilitation Act. To be eligible for disability-related academic
accommodations, students are required to register with the TCU Office of Student Access and
Accommodation and have their requested accommodations evaluated. Students are required
to provide instructors an official TCU notification of accommodation approved through Student
Access and Accommodation. More information on how to apply for accommodations can be
found at https://www.tcu.edu/access-accommeodation/ or by calling Student Access and
Accommodation at (817) 257-6567. Accommodations are not retroactive and require advance
notice to implement.

Technology Policies

Email

Only the official TCU student email address will be used for all course notification. It is your
responsibility to check your TCU email on a regular basis.

Course Materials

TCU students are prohibited from sharing any portion of course materials {including videos,
PowerPoint slides, assignments, or notes) with others, including on social media, without
written permission by the course instructor. Accessing, copying, transporting (to another
person or location), modifying, or destroying programs, records, or data belonging to TCU or
another user without authorization, whether such data is in transit or storage, is prohibited.
The full policy can be found at: https://security.tcu.edu/polproc/usage-polic

Violating this policy is considered a violation of Section 3.2.15 of the Student Code of
Conduct (this policy may be found in the Student Handbook at https://tcu.codes/code/index/),
and may also constitute Academic Misconduct or Disruptive Classroom Behavior

(these policies may be found in the undergradiate catalog at
https://tcu.smartcatalogia.com/current/Undergraduate-Catalog/Student-Policies/Academic-
Conduct-Policy-Details). TCU encourages student debate and discourse; accordingly, TCU
generally interprets and applies its policies, including the policies referenced above, consistent
with the values of free expression and First Amendment principles.

Anti-Discrimination and Title IX Information

Statement on TCU’s Discrimination Policy



TCU prohibits discrimination and harassment based on age, race, color, religion, sex, sexual
orientation, gender, gender identity, gender expression, national origin, ethnic origin, disability,
predisposing genetic information, covered veteran status, and any other basis protected by law,
except as permitted by law. TCU also prohibits unlawful sexual and gender-based harassment
and violence, sexual assault, incest, statutory rape, sexual exploitation, intimate partner
violence, bullying, stalking, and retaliation. We understand that discrimination, harassment,
and sexual violence can undermine students’ academic success and we encourage students
who have experienced any of these issues to talk to someone about their experience, so they
can get the support they need.
e Review TCU’s Policy on Prohibited Discrimination, Harassment and Related Conduct or
to file a complaint: https://titleix.tcu.edu/title-ix/.
e Learn about the Campus Community Response Team and Report a Bias Incident:
https://titleix.tcu.edu/campus-community-response-team/

Statement on Title IX at TCU

As an instructor, one of my respansibilities is to help create a safe learning environment on our
campus. It is my goal that you feel able to share information related to your life experiences in
classroom discussions, in your written work, and in our one-on-one meetings. | will seek to keep
any information your share private to the greatest extent possible. However, | have a
mandatory reporting responsibility under TCU policy and federal law and | am required to share
any information | receive regarding sexual harassment, discrimination, and related conduct
with TCU’s Title IX Coordinator. Students can receive confidential support and academic
advocacy by contacting TCU’s Confidential Advocate in the Campus Advocacy, Resources &
Education office at https://care.tcu.edu/ or by calling (817) 257-5225 or the Counseling &
Mental Health Center at https://counseling.tcu.edu/ or by calling (817} 257-7863. Alleged
violations can be reported to the Title iX Office at https://titleix.tcu.edu/student-toolkit/ or by
calling {817) 257-8228. Should you wish to make a confidential report, the Title [X Office will
seek to maintain your privacy to the greatest extent possible, but cannot guarantee
confidentiality. Reports to law enforcement can be made to the Fort Worth Police Department
at 911 for an emergency and {817) 335-4222 for non-emergency or TCU Police at (817) 257-
7777.

Obligations to Report Conduct Raising Title IX or VAWA Issues

Mandatory Reporters: All TCU employees, except Confidential Resources, are considered
Mandatory Reporters for purposes of their obligations to report, to the Coordinator, conduct
that raises Title IX and/or VAWA (Violence Against Women Act) issues.

Mandatory Reporters are required to immediately report to the Coordinator information about
conduct that raises Title IX and/or VAWA issues, including any reports, complaints or allegations
of sexual harassment, discrimination and those forms of prohibited conduct that relate to
nonconsensual sexual intercourse or contact, sexual exploitation, intimate partner violence,
stalking and retaliation involving any member of the TCU community, except as otherwise
provided within the Policy on Prohibited Discrimination, Harassment and Related Conduct.




Mandatory Reporters may receive this information in a number of ways. For example, a
complainant may report the information directly to a Mandatory Reporter, a witness or third-
party may provide information to a Mandatory Reporter, or a Mandatory Reporter may
personally witness such conduct. A Mandatory Reporter’s obligation to report such information
to the Coordinator does not depend on how he/she received the information. Mandatory
Reporters must provide all known information about conduct that raises Title IX or VAWA
issues to the Coordinator, including the identities of the parties, the date, time and location,
and any other details. Failure of a Mandatory Reporters to provide such information to the
Coordinator in a timely manner may subject the employee to appropriate discipline, including
removal from a position or termination of employment.

Mandatory Reporters cannot promise to refrain from forwarding the information to the
Coordinator if it raises Title IX or VAWA issues or withhold information about such conduct
from the Coordinator. Mandatory Reporters may provide support and assistance to a
complainant, witness, or respondent, but they should not conduct any investigation or notify
the respondent unless requested to do so by the Coordinator.

Mandatory Reporters are not required to report information disclosed (1) at public awareness
events (e.g., “Take Back the Night,” candlelight vigils, protests, “survivor speak-outs,” or other
public forums in which students may disclose such information (collectively, public awareness
events); or (2) during an individual’s participation as a subject in an Institutional Review Board
approved human subjects research protocol {(IRB Research). TCU may provide information
about Title IX rights and available resources and support at public awareness events, however,
and Institutional Review Boards may, in appropriate cases, require researchers to provide such
information to all subjects of IRB Research.

Relevant reporting phone numbers are: 911 for an emergency and (817) 335-4222 for non-
emergency or TCU Police at (817) 257-7777.

Emergency Response Information
Please review TCU’s L.E.S.S. is More public saféty video to learn about Lockdown, Evacuate, and
Seek Shelter procedures. (https://publicsafety.tcu.edu/less-is-more/)

TCU'’s Public Safety website provides maps that show our building’s rally point for evacuation
and the seek shelter location. (https://publicsafety.tcu.edu/)

In the event of an emergency, call the TCU Police Department at 817-257-7777.

Download the Frogshield Campus Safety App on your phone.
{https://police.tcu.edu/frogshield/)

Academic Misconduct

Academic Misconduct (Sec. 3.4 from the TCU Code of Student Conduct): Any act that violates
the academic integrity of the institution is considered academic misconduct. The procedures
used to resolve suspected acts of academic misconduct are available in the offices of Academic
Deans and the Office of Campus Life and are also listed in detail in the Undergraduate Catalog
and the Graduate Catalog Specific examples include, but are not limited to:




- » Cheating: Copying from another student’s test paper, laboratory report, other report, or
computer files and listings; using, during any academic exercise, material and/or devices
not authorized by the person in charge of the test; collaborating with or seeking aid
from another student during a test or laboratory without permission; knowingly using,
buying, selling, stealing, transporting, or soliciting in its entirety or in part, the contents
of a test or other assignment unauthorized for release; substituting for another student
or permitting another student to substitute for oneself.

« Plagiarism: The appropriation, theft, purchase or obtaining by any means another’s
work, and the unacknowledged submission or incorporation of that work as one’s own
offered for credit. Appropriation includes the quoting or paraphrasing of another’s work
without giving credit therefore. {if you are using Turnitin, place information about your
course ID/password or state that items will be checked as part of the TCU Online
assignment submission process. If you want to use Turnitin as a spot check, indicate that
you may use Turnitin for plagiarism detection.]

» Collusion: The unauthorized collaboration with another in preparing work offered for
credit. :

+ Abuse of resource materials: Mutilating, destroying, concealing, or stealing such
material.

« Computer misuse: Unauthorized or illegal use of computer software or hardware
through the TCU Computer Center or through any programs, terminals, or freestanding
computers owned, leased or operated by TCU or any of its academic units for the
purpose of affecting the academic standing of a student.

» Fabrication and falsification: Unauthorized alteration or invention of any information or
citation in an academic exercise. Falsification involves altering information for use in any
academic exercise. Fabrication involves inventing or counterfeiting information for use
in any academic exercise.

» Multiple submission: The submission by the same individual of substantial portions of
the same academic work {including oral reports) for credit more than once in the same
or another class without authorization.

+ Complicity in academic misconduct: Helping another to commit an act of academic
misconduct. '

« Bearing false witness: Knowingly and falsely accusing another student of academic
misconduct.

TCU Online: Our Learning Management System
Getting Started with TCU Online
Technical Requirements: Check your computer is ready by looking at the specifications list.
(https://community.brightspace.com/s/article/Brightspace-Platform-Requirements)
Log In: (using your TCU Network Credentials} -
1. Access via my.tcu.edu > Student Quick Links > TCU Online
2. Login at the following website (http://d2|.tcu.edu) my.tcu.edu
*For information about logging into TCU Online, view these instructions.
{(hitp://tcuonline.tcu.edu/kb/how-do-i-log-in/).




Student Orientation Tutorial for TCU Online: If you have not yet taken the TCU Online Student
Orientation Tutorial, please do so now. To access it, click on the Orientations semester OR view
all courses in your My Courses widget visible upon logging in to TCU Online, Click on the
"Student Orientation Tutorial” to enter the orientation course. Follow the instructions in the
course. You can return to this tutorial at any time.

How This Course Will Use TCU Online:
This course does not utilize TCU Online in any capacity.

Getting Help with TCU Online

if you experience any technical problems while using TCU Online, please do not hesitate to
contact the TCU Online {D2L) Help Desk. They can be reached by phone or chat 24 hours a day,
7 days a week, 365 days a year.

Phone: 1-877-325-7778

Chat: Chat is available within TCU Online in the Help menu on the navigation bar.

If you are working with the Help Desk to resolve a technical issue, make sure to keep me
updated on the troubleshooting progress.

If you have a course-related issue (course content, assignment troubles, quiz difficulties) please
contact me.

Personal Settings & Notifications for TCU Online

As a student, you should set up your account settings, profile, and notifications. To do this you
will login to TCU Online and select your name on the top right of the screen. In the Profile area,
you can upload a photo of yourself and add personal information. In the Notifications area, you
can add your phone number to receive text messages when grades are given as well as
reminder texts for upcoming assignments and quizzes.

Student Success Tools for TCU Online

Pulse

Pulse is a phone app which gives you access to the course calendar, assignments, grades, and
announcements. This app provides a graph that can help you manage your time. Based on the
number of assignments and events on the course calendar for your classes, the graph will
display busy times for class work in the upcoming week. You can use this app to manage your
daily workload, and it includes the ability to view and access course materials offline. You can
download Pulse from the Google Play or Apple Store. You can learn more and download Pulse
here: https://www.d2].com/products/pulse/. -

ReadSpeaker' g

ReadSpeaker includes a number of tools that can enhance your understanding and
comprehension of course materials. ReadSpeaker can create an audio version of content that
you can listen to while on a page within a course or that you can download to listen offline.
ReadSpeaker can also read Microsoft Office files and PDFs. There are additional tools and
features to assist you with reading and focusing in TCU Online, tools that provide support for
writing and proofing text, and tools that can read non-TCU Online content aloud. You can learn




more about how to use ReadSpeaker tools here: https://tcuonline.tcu.edu/how-to-
hub/instructor-how-to-hub-for-tcu-online/integrations-and-mobile/readspeaker/
Support for TCU Students
Campus Offices

e Alcohol & Drug Education Center (817-257-7100, Samuelson Hall basement)
Brown-Lupton Health Center (817-257-7938 or 817-257-7940)
Campus Life (817-257-7926, Sadler Hall 2006)
Center for Academic Services (817-257-7486, Sadler Hall 1022)
Center for Digital Expression (CDeX) {cdex@tcu.edu, Scharbauer 2003)
Counseling & Mental Health Center {817-257-7863, Samuelson Hall basement)
Mary Couts Burnett Library (817-257-7117)
Office of Religious & Spiritual Life (817-257-7830, Jarvis Hall 1%t floor)
Student Development Services (817-257-7855, BLUU 2003)
Center for Writing (817-257-7221, Reed Hall 419)
Transfer Student Center (817-257-7855, BLUU 2003)
Veterans Services (817-257-5557, Jarvis Hall 219)Course Description
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Course Description
This course is intended to be a challenging and exciting capstone for the MS in Business
Analytics curriculum.
The class has elements of ambiguity and uncertainty. In that way it will probably be a lot like
most workplaces. The challenges of business do not come wrapped as case studies or textbooks
or exams. This course is designed to help prepare you to recognize challenges faced by
organizations and to create innovative, value-oriented solutions and to explain and sell those
solutions to management. This is a core competency you must have in the 21% century.
Business analytics is the process of using quantitative methods to derive meaning from data in
order to make informed business decisions. It is a powerful tool in today’s marketplace. Across
industries, organizations are generating vast amounts of data which, in turn, has heightened
the need for professionals who know how to interpret and analyze that information and who
are comfortable with the machine/human interface.
According to a recent study by MicroStrategy, companies worldwide are using data to:

» Boost process and cost efficiency (60 percent)

« Drive strategy and change (57 percent)

e Monitor and improve financial performance (52 percent)
There are three primary methods of business analysis:

» Descriptive: The interpretation of historical data to identify trends and patterns

» Predictive: The use of statistics to forecast future outcomes

~» Prescriptive: The application of testing and other techniques to determine which
outcome will yield the best result in a given scenario

Deciding which method to employ is dependent on the business situation at hand.
This capstone course project is designed to help you, through experiential learning, better
understand how to use each and to illustrate how data insights can drive organizational
performance through:



1. More Informed Decision-Making

2. Greater Revenue

3. Improved Operational Efficiency

Through learning how to recognize trends, test hypotheses, and draw conclusions from data
samples, you can build an analytical framework that can be applied in your everyday decision-
making and help your organization thrive.

Learning Qutcomes:
» Students will:

o Apply innovative problem-solving by using business analytics tools, concepts,
and theories to discover data essential to the effective management of the
enterprise.

o ldentify and analyze the main issues facing today’s enterprise using business
analytics to provide guidance toward solutions.

Make use of interpersonal and team leadership skills.
Contribute to an organizational environment that is effective and conducive to
collaboration, innovation, creativity and ultimately, profit.

o Explain perspectives on business analytics to function and succeed in the
business environment of today and the future.

o Demonstrate Values or Interpret a sense of professional and social responsibility.

This course treats business analytics as a form of Strategic and Entrepreneurial Thinking. In
today’s competitive environment, the size of a company does not correspond to it effectiveness
with data usage. On the one hand, large companies have a budgetary, personnel and data
volume advantage. On the other hand, large companies usually find their most aggressive
competitors to be start-ups. Regardless of the type of company you will work in it is critical, in
the 21% century, to understand data, the ethical use of business analytics, and how to interpret
and deliver value based on the results of data analysis.

Major Connections

This'course is designed to prepare you go succeed at business analytics within corporations.
Companies desperately need problem salvers, critical thinkers, and innovators of both the
quotidian and the rare. You will leave this course better prepared to leverage your strengths,
skills, experience and values into a more dynamic and rewarding work experience.

Required Texts / Materials

There are no required texts for this class. Your company project will be your textbook.

There is no cost for any other parts or assignments in this class.

Additional / Supplementary Resources

Any supplemental articles you will read and videos you will watch are related to the topics of
the day in the syllabus. However, some of these articles will spark your interest and you will
want to follow the topic more deeply. In almost every case you will be able to find related
articles on the same web page as the supplemental article. if you are frustrated in your pursuit
of more information on any topic, please let me know and I'll provide material.

Teaching Philosophy .



My teaching style is predominantly Socratic. Discussion and class engagement play a large role
in my classes and in my grading. You will also have a project grade and you will be evaluated by
your client at the end of the project. Therefore, it is necessary for you to read all of the material
prior to class. My point of view is that you are adults and you will work at learning because of
your investment in it, because you are genuinely interested in knowing more about the inner
workings of corporate success and, not least, you want a good grade. The syiflabus is not meant
as a guide to an “A”. It is a guide to learning based on your own reading, viewing, listening and
engaging in class.

Instructional Methods -

The instructional methods in this course are simple. You read or view the assigned articles and
videos. We discuss them in class in the context of the days lecture topics and sometimes you will
engage in 1 or more class activities which will include written papers, Web activities,
discussions, presentations, a personal reflection, and video criticism. At home you will have at
least one assignment in reading, presentations or writing before each class. For these reasons it
is important for you to attend every class.

Final Grade Elements / Grade Breakdown: Grading Scales
PLEASE NOTE: Your grade scale is below.

Grade | Score Grade | Score
1A 94-100 C 74-76.99
A- 90-93.99 C- 70-73.99
B+ 87-89.99 F 69.99-0
B 84-86.99
B- 80-83.99
C+ 77-79.99
Late Work

Late work, and makeup, will be accepted with appropriate documentation e.g. a doctor’s note,
a note from your work supervisor on company stationery, or a university excused absences.

Grading Concerns. |

Your grade is in large part(55%) determined by your engagement and participation in class
discussion. The reason for this is because through discussion, whether during class or in
asynchronous threaded discussion, you demonstrate your understanding of the material and
contribute to your own learning as well as your classmates and professor. Through our
combined efforts we all can elevate and expand our learning and understanding. Please see the
rubric below, and the text below that, explaining how much of your grade is derived.

Participation is a vital part of this online course. Participation in an online course means
engagement with course content, active participation in discussion boards and course
activities, and ongoing communication with me as your instructor and with your peers.
Satisfactory par'tii:ipation in an online context means being in the course around 6 hours a



week to check announcements, read and respond to discussion prompts, and review the
readings/topics for the week’s discussions and activities. Your participation will be measured
through your engagement with course content and materials and through your attendance.

Engagement: You can actively participate in the course by reviewing all the content,
and, responding to threaded discussions and assignment due dates. | welcome your
comments, thoughts, questions, and hope you take an active role in the online
discussions.

o Your attendance will be taken in each class period. To be counted in attendance
you will have to have your camera on o, if you have no camera or a technical
issue you can speak out when your name is called.

o Each discussion board will have instructions included with it. You will need to
post before other student posts can be seen.

Team Work: Team members will be assigned by the instructor. Students will use
collaborative work spaces to which all users will have access (including the instructor),
through Google Drive, TCU Online Chat, or the TCU Online Locker.

Student Engagement: As your instructor, | can view the content access information for
the students in the course. This insight into your engagement with our course materials
is meant to help me track your course progress. You can also view your course progress
to track your engagement with course material throughout the semester.

Faculty Engagement: You will receive a variety of instructor feedback in this online
course. | will reply to emails, phone calls, zoom callas, and provide comments on any
assignments. [ will also communicate course information with you regularly through
class announcements and email.

Discussion Rubric: The Discussion Rubric should guide you as to what the expectations
are for your posts and how your participation will be graded. (see below)

o Highest range (A) - Excellent Performance, someone at this level regularly
initiates and contributes towards the understanding of the material. Their
comments make deep and significant contributions to our class discussions.
These students attend all classes, are always prepared and consistently and
reliably perform at this high level.

o M'edium‘ range (B) - Very good performance, Student attends all the classes and

~ 'makes a greater than average contribution to class discussions. These students
are well prepared for classroom discussions.

o Low range(C) - Person at this level makes only sporadic contributions, but they
are present at most lectures.

© Lowest range (D) - Person attends majority of the class, but make little or no

contribution.

o ' Please note that this is a subjective determination (as it Is in business world
" also).Participation mark will be ascertained at the sole discretion of the
instructor using the above template.
'®=  Attending class is required. An absence is defined as not being present
for class in any capacity, virtual or in person, and unable to take partin
discussion or presentations.



Class Norms & Netiquette

All members of the class are expected to follow rules of common courtesy in all email
messages, discussions, and chats. If | deem any of them to be inappropriate or offensive, | will
forward the message to the Chair of the department and appropriate action will be taken, not
excluding expulsion from the course. The same rules apply online as they do in person. Be
respectful of other students. Foul discourse will not be tolerated. Please take a moment and
read the basic information about netiquette (http://www.albion.com/netiquette/).
Participating in the virtual realm, including social media sites and shared-access sites
sometimes used for educational collaborations, should be done with honor and integrity.
Please review TCU’s guidelines on electronic communications {email, text messages, social
networks, etc.) from the Student Handbook. {https://tcu.codes/policies/network-and-
computing-policy/e-mail-electronic-communications-social-networks/). The policies referenced
above are consistent with the values of free expression and First Amendment principle

Course Outline
(Subject to change throughout the term)

Wednesday, January 12, 2022

Introductions, Progress/Status Reports, Cutstanding Issues, Resources Needed, Any Additional
Discussion.

Class Discussion: Critical Thinking, Agency, Courage, Funding, Future

Articles:

https://www.webfx.com/internet-real-time/

The Internet in real time.

hitps://uridefense.com/v3/ http://futurecfcio.blogspot.com/2019/11/the-very-characteristics-of-digital-

era.html NK6Z8K8YTIAIVDIMo2PVQxjcH7f1AIF92Ht DbtXiOVismwtcKjRMcTQIGhPEmMpFYIXUP 1vZ AXxxu
g$

The VUCA environment.

Wednesday, January 19, 2022

Progress/Status Reports, Outstanding Issues, Resources Needed, Any Additional Discussion.
Class Discussion: Why Companies Lose Their Way

Articles: ' .
https://www.cbinsights.com/research/corporate-innovation-product-

fails/?utm source=CB+Insights+Newsletter&utm campaign=854aa52ce9-

Top Research Briefs 12 22 2018&utm medium=email&utm term=0 9dc0513989-
854aa52ce9-88848373

What did these companies do after these failures?

https://urldefense.com/v3/ https://amp-theatlantic-
com.cdn.ampproject.org/c/s/amp.theatlantic.com/amp/article/620522/ :1IK6Z8KBYTIAIXO8G
Xo8tH 9xi2DQcrGkyoFd09VR Eoj SZD9FDGHHJ-L5 d4BrgRijwS56AVMCataAs

The End of Trust. How do you make data trustworthy? What about people?




Wednesday, January 26, 2022

Progress/Status Reports, Outstanding issues, Resources Needed, Any Additional Discussion.
Class Discussion: Frameworks of Corporate Entrepreneurship and Innovation.

Articles:

Which one best describes your company
http://www.web-strategist.com/blog/2016/07/26/the-ten-types-of-corporate-innovation-

programs/

29 Big Ideas that will change our world in 2022
https://www.linkedin.com/pulse/29-big-ideas-change-our-world-2022-linkedin-news

Industry skills report
https://pages.coursera-for-business.org/rs/748-MIV-116/images/Coursera-Industry-Skills-
Report-2021.pdf

Wednesday, February 2, 2022

Progress/Status Reports, Outstanding Issues, Resources Needed, Any Additional Discussion.
Class Discussion: Do Corporate Organizations Have Room For [nnovation?

Articles: :
https://hbr.org/2016/10/when-big-firms-are-most-likely-to-

innovate?utm medium=email&utm source=flipboard

https://hbr.org/2012/06/how-managers-become-leaders

https://www.mckinsey.com/business-functions/organization/our-insights/shattering-the-
status-guo-a-conversation-with-haiers-zhang-ruimin?cid=app

‘Wednesday, February 9, 2022

Progress/Status Reports, Outstanding Issues, Resources Needed, Any Additional Discussion.
Class Discussion: Entrepreneurship in Other Contexts: Nonprofit and Government
Organizations.

Articles:

All the privacy apps you should have downloaded
https://mashable.com/article/best-privacy-apps-ios-iphone-android/

https://www.linkedin.com/pulse/book-recommendations-nicolai-tansen/

Wednesday February 16, 2022
Progress/Status Reports, Outstanding Issues, Resources Needed, Any Additional Discussion.
Class Discussion: Strategic Thinking

https://www.blockdata.tech/blog/spotlight/Blockdata-interviews-LTO-Network-
founders?utm source=CB+Insights+Newsletter&utm campaign=c8754657e8-




newsletter general Tues 20210706&utm medium=email&utm term=0 9dc0513989-
c8754e5728-88848373

Wednesday, Febrﬁary 23, 2022

Progress/Status Reports, Outstanding Issues, Resources Needed, Any Additional Discussion.
Class Discussion: The Reality of Corporate Constraints.

Articles:

A leader who knows how to change the future
https://knowledge.wharton.upenn.edu/article/haiers-zhang-ruimin-success-means-creating-

the-future/

The importance of negotiating your salary
https://www.forbes.com/sites/womensmedia/2020/01/08/the-most-critical-reason-you-need-
to-negotiate-how-to-do-it-effectively/?sh=36¢fe2d430ed

10 ridiculously smart questions you should ask in a job interview
https://www.theladders.com/career-advice/career-advice-ten-ways-ridiculously-successful-
people-think-differently-amp

Wednesday, March 2, 2022

Progress/Status Reports, Outstanding Issues, Resources Needed, Any Additional Discussion.
Class Discussion: Is Data a Corporate Constraint on Innovation?

Articles:

https://www.wipo.int/wipo_magazine/en/2019/05/article 0001.html

IP In a Data driven world

https://www.vice.com/en/article/z3xw3x/new-research-vindicates-1972-mit-prediction-that-
society-will-cotlapse-soon
Good data ?

BREAK

Waednesday, March 16, 2022

Progress/Status Reports, Outstanding Issues, Resources Needed, Any Additional Discussion.
Class Discussion: What do the online corporations you interact with know about you?
Articles :
https://www.forbes.com/sites/zakdoffman/2021/01/03/whatsapp-beaten-by-apples-new-
imessage-update-for-iphone-users/?sh=4977cc473623

Note: You might want to check what data your apps are collecting.

https://www.theguardian.com/commentisfree/2018/mar/28/all-the-data-facebook-google-
has-on-you-privacy

Wednesday, March 23, 2022



Progress/Status Reports, Outstanding Issues, Resources Needed, Any Additional Discussion.
Class Discussion: Ethics of Data Harvesting

Articles :
https://www.eckerson.com/articles/data-ethics-the-new-data-governance-challenge

https://datascien_ce.foundati0n/datataEk/ethics-in-business-anaIvtics

Wednesday, March 30, 2022 Progress/Status Reports, Outstanding Issues, Resources Needed,
Any Additional Discussion.

Class Discussion: Sustained Entrepreneurial Performance in the 215 Century.

Articles :

https://www.entrepreneur.com/article/307829

Factors for Sustaining Corp. Entrepreneurship

https://mitsloan.mit.edu/ideas-made-to-matter/how-big-firms-leverage-artificial-intelligence-
competitive-advantage
Keep these examples in mind

Wednesday, April 6, 2022

Progress/Status Reports, Outstanding Issues, Resources Needed, Any Additional Discussion.
Class Discussion: Any topic of interest to students. Perhaps a bit of historical context on how
the U.S. became the most powerful and richest nation in history. Why is there so much turmoil
in the world right now? Will it end?

Wednesday, April 13, 2022 Progress/Status Reports, Outstanding Issues, Resources Needed,
Any Additional Discussion.

Class Discussion: Global Corporate Evolution and BA.

Articles :

https://www.selecthub.com/business-analytics/business-analytics-trends/

https://databricks.com/wp-content/uploads/2021/04/enable-data-ai-scale-transform-
organization-v11-042321.pdf
Constraints and Opportunities

Wednesday, April 20, 2022

Final Progress/Status Reports- Written Report Due, Outstanding Issues, Resources Needed, Any
Additional Discussion.

Class Discussion: On projects presented

Wednesday, April 27, 2022 - Last Class Day

Final Progress/Status Reports- Written Report Due, Outstanding Issues, Resources Needed, Any
Additional Discussion.

Class Discussion: On project presented and class wrap up



Thurs/Fri, April 28-29, 2022 - STUDY DAYS
Mon/Fri, May 2-6 — EXAM DAYS
Saturday, May 7, 2022 - GRADUATION



